FACULTY APPLICANT SELF-IDENTIFICATION SYSTEM (FASI)
INSTRUCTIONS FOR SCHOOL OF MEDICINE USERS

GENERAL BACKGROUND

The Faculty Applicant Self-Identification System (FASI) enables you to collect gender and
ethnicity data from applicants for faculty positions, and to create applicant pool grids for the
School of Medicine’s Office of Academic Affair’s review of the search and offer and for your
final candidate’s faculty long form.

Why do we do this?

Because Stanford University is a Federal contractor, we are required to request information
regarding the gender, race and ethnicity of applicants for employment and to prepare periodic
reports on this information. FASI facilitates this data collection by asking each of our faculty
applicants to identify their gender and ethnicity. The collection of this information also enables
Stanford to meet its commitment to equal employment opportunity by allowing it to assess the
diversity of its applicant pools and the effectiveness of its affirmative action efforts. FASI is
required for all searches except in cases where the Provost has approved a search waiver.

How does FASI work?

FASI is a web-based application. Access the system at https://fasi.stanford.edu
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You must be on the “Home” page to navigate through the system. There is a ““Home
navigation button on each page.

Department administrators and faculty affairs staff can upload applicant names into the
system from Excel or add them individually as the applicant names arrive.

Department administrators instruct the system to send an email to each applicant
requesting applicant to log into a website and answer self-identification questions.

The website collects the statistics and populates the applicant grid for department
administrators to use for reporting aggregated applicant pool gender and ethnicity on the
candidate’s faculty appointment papers (long form).

This system is accessible to all department administrators conducting searches. The School
of Medicine’s Office of Academic Affairs provides the Provost’s Office with a list of FASI
users and normally requests access for new faculty affairs administrators at the same time
they are granted FAST|FAC FAA access. To request access for others or to seek FASI help,
contact Jane Volk-Brew.
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INSTRUCTIONS

1. GO TO THE WEB ADDRESS https://fasi.stanford.edu/

2. CREATE THE SEARCH.

TIP: Access to a search and its data is not shared. The person who will enter the applicant

data must create the search in FASI. Contact Jane Volk-Brew about user access issues.

From the home page select the link “Create Search” and fill out the online form.
In the “Department” field enter a text string containing the following elements:
{department name} ({division name if applicable}) {specialty keywords}

Here are examples:
Medicine (Gastroenterology) Division Chief
Molecular/Cellular Physiology adrenergic receptors

TIP: This text field is limited to 50 characters + spaces; be strategic, succinct and
abbreviate when necessary. Type this text string in a Word document and use the Word
Count tool to check the length.

Select the target professorial rank from the “Position” field menu. TIP: if the search is
unrestricted for line and/or rank, choose “Other Position”.

The PeopleSoft position number authorized by OAA for the search must be entered into
the “Billet” field. This field is not optional for School of Medicine users.

Here is an example:
12345

Click on “Create Search”, then click on ““Home””. TIP: ignore the warning that you have
not saved anything and click on “Ok”. You have created your search; you can confirm this
because it appears on the “Maintain Search Status” page.

3. MAINTAIN SEARCH STATUS
On the “Home” page click on the left hand navigation entitled “Maintain Search Status”.

Use this page to maintain the search, that is, to delete a search before an email is sent or
to close or reopen a search.
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You can toggle the status between “Open” and “Closed” as needed, so long as the search
is retrievable (allowed for up to two years). The FASI system tracks searches by academic
year with a new web address assigned each year. TIP: keep a separate record of the
searches by the year created and their web addresses.

TIP: if a search does not result in a candidate for whom a long form is prepared and OAA
authorizes that the search be reinitiated with new advertising, close the existing FASI
search record and create a new one. This will establish separate applicant pools.

4. ADD APPLICANT NAMES AND EMAILS TO THE SYSTEM.

You have two options in the left hand navigation:

Select the link “Add Applicants” to add names individually. FASI will check for
duplicate email addresses added to the same search with this method.

OR
“Upload Applicants” allows you to add a group of names with a file. TIP: FASI does not

check for duplicate email addresses added to the same search with this method, so
check the applicants’ names and email addresses before uploading the file.

To use the “Upload Applicant” method, first create an Excel spreadsheet with two
columns, one containing the applicants’ names formatted as {last name, first name}
and another with the applicants’ email addresses. There must be no row of column
headings. Example:

Peep, Little Bo | sheep@yahoo.com
Pan, Peter wontgrowup@gmail.com
Dog, Clifford bigred@aol.com

Save the Excel file as a tab delimited text file {filename}.txt. TIP: use the PeopleSoft
position number assigned to the search and reference an applicant group number.
Each time you upload additional files with new applicant names, increment the group
number. Examples:

Position_12345 groupl.txt

Position_12345_ group2.txt

Position_12345_ group3.txt

Office of Vice Provost for Faculty Development and Diversity | Stanford University 3
School of Medicine, Academic Affairs | Stanford University
http://med.stanford.edu/academicaffairs/administrators/orientation/FASI_userlnstructions.pdf



FACULTY APPLICANT SELF-IDENTIFICATION SYSTEM (FASI)
INSTRUCTIONS FOR SCHOOL OF MEDICINE USERS

On the “Upload Applicants” page, select the search from the menu, browse for the file
on your computer, and add it to FASI.

TIP: whichever method you use to add applicants, if you have more than one open search,
be sure to select the right search from the pick list each time you add an applicant or
upload a text file.

Users are encouraged to add applicants regularly in batches throughout the open
application period, rather than waiting until a complete list of all the applicants is
available. Upload separate .txt files or add applicants individually.

TIP: print or make a PDF of the confirmation page for each upload. Note the date and time
on the PDF if the information does not automatically appear in the footer of your PDF.

5. MAINTAIN APPLICANTS AND EDIT

TIP: click on the “Maintain Applicants” link in the left navigation to use the “Display
Applicants and Edit” page to check, and correct if necessary, an applicant’s name and
email address before sending the FASI email to applicants. Extra spaces or characters,
inadvertently duplicating an email address for more than one applicant, or other
inaccuracies may interfere with the applicant receiving the email and responding.

All of the applicants appear sorted by last name on the "Maintain Applicants" page. TIP:
users cannot sort by any of the columns in FASI, but you can copy and paste the data into
Excel to perform this function. In the browser, go to the Edit menu and choose “Select All”
and “Copy”. Open a new worksheet in Excel and place the cursor in the top left cell. In the
Edit menu choose “Paste”. Click on the merged header cells with the label “Search”, go to
the Format menu, choose “Cells”, click on the Alignment tab, and deselect “Merge cells”.
Now you can select the entire data set and sort them as usual from the Data menu.

If an applicant was added to the wrong search, you can delete him or her using this page
but only before an email is sent out to him or her. Click on “Delete” and confirm the
deletion when prompted.

If you discover the error after the email has been sent, contact Yan Li, Office of the Vice
Provost for Faculty Development and Diversity. Identify the wrong and correct searches
and the applicant in your help request.
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6. ASKAPPLICANTS TO SELF-IDENTIFY.

The system does not send the emails automatically; you must initiate the sending of
emails to applicants.

From the home page select the link “Send Emails to Applicants” on the left, check the
box next to the search for which you want to send the emails, then click on the “Send
Emails” button.

TIP: send the email to an applicant as soon as possible after his/her application is
received. This may result in a good response rate and will help avoid the situation of not
having asked an applicant to self-identify before his/her application is declined or
he/she withdraws from the search.

Return regularly to “Send Emails to Applicants” and send a second email as a reminder.
This second email will only go to applicants who have not responded. There is a two
email limit for each email address in a search, so each applicant will receive your email a
maximum of two times no matter how many times you click on “Send emails”. If all of
the applicants have either responded or received two emails, the system will refresh the
page with a small message in red that “There are no non responders in that search” and
not allow you to send any more emails except to new applicants who are added to the
search.

If an applicant has been added to more than one search, he or she will receive separate
email at least once, and no more than twice, for each search in which his or her name
appears.

TIP: print or make a PDF of the confirmation page for each successful email sending; it is
date and time stamped and may be helpful for tracking process.

WHAT THE APPLICANT RECEIVES AND THE FORM THE APPLICANT COMPLETES
A sample of the email message the applicant will receive is available through the

“What Applicant Receives” link on the left side of the “Home” page and appears on
OAA’s website at https://fasi.stanford.edu/what applicant rec.pdf.
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When the applicant clicks on the link provided in the email, he/she is connected to a
FASI applicant logon page and asked to supply the email address to which the message
was sent. After the applicant enters the email address, a web form appears explaining
that Stanford is a Federal contractor required to request, collect and report on the
gender and race/ethnicity of applicants for employment. The responding applicant
must select a gender. Two questions are asked with respect to race and ethnicity. An
applicant may select one or more racial classifications (resulting in a count in the “Two
or More Races” column of the applicant pool grid) or may decline to identify race and
ethnic background. The classifications are defined at
http://med.stanford.edu/academicaffairs/faaTools/RaceEthnicityDefinitions.pdf.

After the responding applicant completes and submits the form, FASI confirms that the
information was received.

7. INTERIM VIEW OF THE DATA YOU HAVE COLLECTED.

You may observe the aggregated diversity of the applicant pool for each of your
searches on the “Display Applicant Grid” page at any time.

The table displays your open searches by default. To display a list of closed
searches or of all searches, click on the appropriate radio button and on the
“Filter” button. To return to a list of open searches only, click on the “Reset”
button.

Click on the “View” link to the right of the search for which you want to see the
aggregated applicant pool data.

Open search applicant pool data is reported in an “Interim” grid. If your search
contains data from applicants identifying for “2 or more race” combinations, there
will be a count in the right most column and more information provided at the
bottom of the page. If you want to keep a copy of the "2 or more race” combinations
from your search, save from the “Interim” grid by copying into an Excel spreadsheet.
It will not appear on the “Final” grid. TIP: include a copy of the “Interim” grid with the
Search & Offer materials for the Office of Academic Affairs’ review.
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Closed search applicant pool data is reported in a “Final” grid, with the inclusion
of a field in which to identify the recommended candidate and the EEO-1
race/ethnicity definitions. The additional information about identified “2 or more
race” combinations does not appear on the “Final” grid. You must upload a copy
of the “Final” grid to FAST | FAC Section 2D for each faculty candidate emerging
from a search. “Interim” applicant grids will not be accepted.

A sample of the “Final” applicant pool grid appears at
http://med.stanford.edu/academicaffairs/administrators/applicant pool grid ex
ample 2010.pdf.

Print the report at any time by selecting "Print PDF" at the bottom of the page.
8. CLOSE YOUR SEARCH.

After the Office of Academic Affairs approves the Search and Offer, your search is
done. Go to the “Home” page and select “Maintain Search Status”. Select the
search and toggle the “Close” radio button, then click on the “Update” button.

9. PRINT AND SAVE THE FINAL APPLICANT POOL GRID.

From this point forward, and unless you change the search status back to open, the
applicant pool grid available on the “Display Applicant Grid” page is “Final”.

From the “Home” page, select the “Display Applicant Grid” link on the left. On the
“Display Applicant Grid” page, filter for closed searches, select the search you are
working on from your list of closed searches, click on “View”.

To print the grid, click on "Print PDF" at the bottom of the page and save the file to
your computer to upload into FAST|FAC Section 2D of your faculty candidate’s action.

TIP: Double-check the grid numbers against any numbers mentioned in the search
narrative of the (long form), and if there is a discrepancy, the search report should
contain a good faith effort to factually explain it (allowing for the fact that the
department neither knows which applicants have responded nor how they self-
identified). For example, applicants with a Ph.D. who applied to a clinical search for
which a M.D. is required, might not be included as official “applicants” and asked to
self-identify, but should be mentioned in the search report. If you have questions
regarding a discrepancy and providing an explanation, contact Rebecca Robinson, Craig

Spencer, or Judith Cain.
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